Copyright Notice


Configuration Guide for SAS® 9.2 Foundation for Microsoft® Windows® for x64
Copyright © 2008, SAS Institute Inc., Cary, NC, USA.

All rights reserved. Printed in the United States of America. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, by any form or by any means, electronic, mechanical, photocopying, or otherwise, without the prior written permission of the publisher, SAS Institute Inc. Limited permission is granted to store the copyrighted material in your system and display it on terminals, print only the number of copies required for use by those persons responsible for installing and supporting the SAS programming and licensed programs for which this material has been provided, and to modify the material to meet specific installation requirements. The SAS Institute copyright notice must appear on all printed versions of this material or extracts thereof and on the display medium when the material is displayed. Permission is not granted to reproduce or distribute the material except as stated above.

U.S. Government Restricted Rights Notice. Use, duplication, or disclosure of the software by the government is subject to restrictions as set forth in FAR 52.227-19 Commercial Computer Software-Restricted Rights (June 1987).


SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries.

® indicates USA registration.

Other brand and product names are trademarks of their respective companies.
Table of Contents

About this Guide ...................................................................................................... ii

Chapter 1: Post-Installation Setup for the Metabase Facility ............................... 1
  Setting Up the System Repository Manager Files ............................................ 1
  Registering the SASHELP Repository in the Repository Manager ............... 1
  Converting Version 6 SAS/EIS Metabases to Version 8 Repositories .......... 2

Chapter 2: Post-Installation Instructions for National Language Support (NLS) ................................................................................................................. 3
  Chinese, Japanese, and Korean DBCS Support ............................................... 3
    Changing the Default DBCSLANG and DBCSTYPE Option Settings .......... 3
    Changing the Configuration Files for Unicode Server ................................ 3
    Asian Font Catalogs ...................................................................................... 4
    Installing Traditional Chinese Fonts ............................................................ 4
    Specifying the Font Catalog in the Configuration File for Traditional Chinese Fonts .............................................................. 4
    Specifying the Font Catalog in a SAS Session for Traditional Chinese Fonts ................................................................. 4
  European Language Support .......................................................................... 4
    Configuring SAS 9.2 for Locale ................................................................... 4
    Changing the Default LOCALE Option Setting .......................................... 5
    Running SAS in a Different Locale ............................................................... 5
    Additional Information ................................................................................ 5
    Locale Setup on the Remote Server ............................................................ 5
    Devmaps and Keymaps for SAS/GRAPH Software ...................................... 6

Chapter 3: SAS/ACCESS Interfaces .................................................................... 9
  Configuring SAS/ACCESS Interface to MySQL Software ............................... 9
  Configuring SAS/ACCESS Interface to ODBC Software ................................ 9
    SAS/ACCESS ODBC Conversion Utilities .................................................... 10
    AS/400 Users ............................................................................................... 10
    Microsoft SQL Server Users ..................................................................... 11
  Configuring SAS/ACCESS Interface to Oracle Software ................................ 12

Chapter 4: Post-Installation Setup for SAS/ASSIST Software ......................... 13
  Adding a Master Profile ................................................................................ 13

Chapter 5: Post-Installation Setup for SAS/CONNECT Software ....................... 15
  Storing and Locating SAS/CONNECT Script Files ........................................ 15
  TCP/IP ......................................................................................................... 15
  Configuring the SAS Windows Spawner Program ........................................ 15

Chapter 6: Post-Installation Configuration for SAS/IntrNet Software ................ 17
  Overview ..................................................................................................... 17
  Installing and Configuring SAS/IntrNet Software ....................................... 18
    Install Your Web Server Software ............................................................ 18
    Install Your SAS Software ......................................................................... 18
    CGI Tools Installation Dialogs ................................................................. 18
    Installing CGI Tools and SAS Foundation on Machines with Different Operating Systems .......................................................... 21
About this Guide

This document provides configuration instructions for SAS 9.2 Foundation, which is made up of server-side Base SAS and a variety of server-side SAS products (the exact products vary by customer). Information about the configuration of mid-tier and client-side products are available from your SAS Software Navigator.

The server-side configuration instructions contained in this document are for the configuration of a generic SAS server. For information about configuring OLAP, workspace and stored process servers, please see SAS Integration Technologies: Server Administrator’s Guide. This material can be found at http://support.sas.com/documentation/configuration/index.html.
Chapter 1: Post-Installation Setup for the Metabase Facility

In Version 7 of the SAS System, the SAS/EIS Metabase facility was converted to the V7 Common Metadata Repository. The Common Metadata Repository is a general-purpose metadata management facility that provides common metadata services to various metadata-driven applications.

Using the Common Metadata Repository requires a one-time setup of the system the repository manager. If the repository manager was set up in a previous release it may not need to be set up again. The steps in the following sections should be completed before you attempt to use the Metabase Facility. For Metabase Facility users who were using a release prior to Version 7, using the Common Metadata Repository requires a conversion. For more information, see the Version 8 OLAP Server Topic “Converting Legacy Metabases.”

Setting Up the System Repository Manager Files

Complete the following steps to set up the necessary system repository manager files. You must have write access to SASHELP in order to specify the system repository manager.

Note: This process sets the default location for the repository manager for your site. Individual users may specify their own repository manager location by following the steps below and not selecting the Write values to system registry check box.

1. Create a directory that will be dedicated exclusively to the storage of repository manager files, for example: !SASROOT\RPOSMGR.

   This directory should not be used to store other SAS files.

2. At a SAS command line, type REPOSMGR and then select Setup Repository Manager.

3. In the Repository Manager Setup window, Library will default to RPOSMGR. For Path, specify the path from Step 1, above, and then select the Write values to system registry check box. Then select OK.

4. In the resulting dialog window, select Yes to generate the necessary repository manager files.

This completes the setup for the System Repository Manager. You can create additional repository managers (a user repository manager, for example) by repeating the steps above and by using a different path.

Registering the SASHELP Repository in the Repository Manager

The SASHELP repository is used in various samples, including the SAS/EIS Report Gallery templates. Before beginning the steps below, a repository manager must be created (see previous section). Complete the following steps to register the SASHELP repository in the Repository Manager:

1. At a SAS command line, type REPOSMGR and then select Repository Registration.

2. In the Repository Registration window, select New.

3. In the Register Repository (New) window, type SASHELP (in uppercase) in the Repository field, and then type the full directory path where the CORE catalog is located in the Path field, for example:

   !SASROOT\CORE\SASHELP
4. In the Description field, you can type any character string (for example, SASHELP Repository). Select OK to close the Register Repository (New) window. Select Close to exit the Repository Registration window.

Note: Repositories cannot span multiple directories because the path cannot contain concatenated directories. If you have existing metabases in concatenated directories, you should copy the metabases to a single path that will be referenced as a repository.

**Converting Version 6 SAS/EIS Metabases to Version 8 Repositories**

For step-by-step instructions on converting Version 6 metabases to Version 8 repositories, please refer to the topic “Converting existing SAS/EIS metabases” in the SAS/EIS online Help.
Chapter 2: Post-Installation Instructions for National Language Support (NLS)

This chapter contains information on post-installation configuration for Asian and European language support.

**Important:** To run a localized SAS image, your operating system must be configured to use a Windows for x64 regional setting appropriate to the localized image. You may experience unexpected results if the regional setting and the localized image are not consistent. If multiple SAS localizations have been installed on the system, you may need to change the regional setting for each localized SAS image before invocation. For information on how to change or to use regional settings, refer to your Microsoft Windows for x64 documentation.

**Chinese, Japanese, and Korean DBCS Support**

This section explains how to change the default settings for the `DBCSLANG` and `DBCSTYPE` system options and how to specify Asian font catalogs.

**Note:** The `DBCSLANG` and `DBCSTYPE` system options (described in the next section) should be used to set locale for Asian character sets only. The `LOCALE` and `ENCODING` system options, described in the SAS Help System, are used to set locale for European languages.

**Changing the Default DBCSLANG and DBCSTYPE Option Settings**

When you install SAS 9.2 Foundation and choose to load NLS language translations, the installation automatically sets default values for the `DBCSLANG` and `DBCSTYPE` system options based on the language selection and platform. For example, if you install Primary Japanese on Windows 2000, the configuration file (`!sasroot\nls\ja\sasv9.cfg`) sets `DBCSLANG` to `JAPANESE` and `DBCSTYPE` to `PCMS`.

**Changing the Configuration Files for Unicode Server**

There are two configuration files. The first, `c:\program files\sas\sas 9.2\sasv9.cfg`, points to the second, `c:\program files\sas\sas 9.2\nls\1d\sasv9.cfg`. To run SAS as a Unicode Server, edit the configuration files for your system with the following changes:

1. DBCS settings are in the second configuration file above. Comment-out the `DBCSLANG` and `DBCSTYPE` options in that file. For example:
   ```
   /* -DBCSTYPE PCMS */
   /* -DBCSLANG JAPANESE */
   ```

2. Add the `ENCODING` option and set the value to UTF-8 (`ENCODING=UTF-8`):
   ```
   -ENCODING=UTF-8
   ```

3. Add the `FONT` and `SYSGUIFONT` options and set the values to a TrueType font e.g., Thorndale Duospace.

For more information, please visit [http://support.sas.com/](http://support.sas.com/) and see the white paper SAS 9.1.3 SP4 Unicode Environment.
Asian Font Catalogs
The default configuration files for Asian language editions already contain font definitions. (However, the configuration file for DBCS extensions does not contain font definitions.) Asian font catalogs reside in subdirectories (by language) for easy installation. If you want to change the font catalog, you can specify it in either the configuration file or in your SAS session.

With the exception of Traditional Chinese fonts, Asian fonts reside in the SASHELP.FONTS catalog. The default configuration file for the Traditional Chinese language edition already contains font definitions. (However, please note that the configuration file for DBCS extensions does not contain font definitions.) To use Traditional Chinese fonts, you can specify them either in the configuration file or in your SAS session.

Installing Traditional Chinese Fonts
To use Traditional Chinese fonts, you must install the Traditional Chinese localization. You will also need to modify your configuration file, as described in the following section.

Specifying the Font Catalog in the Configuration File for Traditional Chinese Fonts
If you are not running a Traditional Chinese localization but you want to use the Traditional Chinese fonts, you need to modify the configuration file to set GFONTx to
- set gfontx !SASROOT/nls/zt/font-name

In this statement,
- $x$ represents a value from 0-9.
- $font-name$ represents the name of the font catalog you want to use.

Specifying the Font Catalog in a SAS Session for Traditional Chinese Fonts
To specify the font catalog in a SAS session, submit the following LIBNAME statement:
- libname gfontx !sasroot
ls
langcode\font-name

In this statement,
- $x$ represents a value from 0-9.
- $font-name$ represents the name of the font catalog you want to use.

European Language Support
The following sections explain different methods for configuring your system for locale, describe how to set up your local session to transfer data to a remote session, and provide a list of devmap and keymap values that match the locales on your operating system.

Configuring SAS 9.2 for Locale
If you want to configure your SAS session for a locale other than the default locale, you have two methods from which to choose to achieve that goal. This section explains those methods.
Changing the Default LOCALE Option Setting

When you install SAS 9.2 Foundation and you choose to load NLS language translations, the installation automatically sets the LOCALE system option to the default value for the language installed. The LOCALE option is set in the system configuration file for each language installed.

For example, !SASROOT\nls\fr\sasv9.cfg sets LOCALE to French_France by default.

If you want to change the default locale setting for SAS, you can set the LOCALE system option to the appropriate language in your system configuration file.

For example, you can edit !SASROOT\nls\fr\sasv9.cfg and change -locale French_France

to -locale French_Canada.

Running SAS in a Different Locale

To set the locale for SAS 9.2 at your site, add the LOCALE system option to your configuration file. You can find a list of locale values in the SAS 9.2 National Language Support (NLS): User’s Guide.

When you read or write a file, SAS 9.2 expects the data in the external files to be in the session encoding. To specify a different encoding, refer to the documentation for the ENCODING system option in the FILENAME, INFILE, or FILE statement in the SAS 9.2 National Language Support (NLS): User’s Guide.

When LOCALE is set, the ENCODING system option will be set to an encoding that supports the language for the locale. SAS 9.2 expects user data to be in the encoding that matches the ENCODING option. If you prefer an encoding other than the most common encoding for the locale, you can also set the ENCODING system option in the configuration file.

When the ENCODING option is set, the TRANTAB option will always be set to match the ENCODING system option. The transport format trantabs (translation tables), set by the TRANTAB option, are used by the CPORT and CIMPORT procedures to transfer SAS data files. These trantabs are also used by the UPLOAD and DOWNLOAD procedures for transferring files and catalogs, remotely submitting code to the server, and returning logs and listings to the client.

The Output Delivery System (ODS) will create output using the encoding that matches the ENCODING system option. If you would like your output created using a different encoding, please refer to the documentation for the Output Delivery System.

For more information, refer to the Base SAS 9.2 Procedures Guide in base SAS software for documentation about PROC CPORT and PROC CIMPORT. Refer to the SAS/CONNECT 9.2 User’s Guide for documentation on PROC UPLOAD and PROC DOWNLOAD.

Additional Information

Depending on the applications you run, additional setup may be required for your system. Refer to the following sections for more information about configuring your system to run with alternate locales.

Locale Setup on the Remote Server

Note: The %LS ( ) macro was introduced in SAS 9.1. This macro replaced the functionality of the Locale Setup Window that was used in previous releases.

References to “SAS System 9” in the following section refer to all releases of SAS software from SAS System 9 forward.
If you are running SAS System 9 as both your client and server sessions, it is not usually necessary to run the `%LS( )` macro to do any further locale setup. The locale of a server should be compatible with the locale of your client session; otherwise, your data may be corrupted.

If your SAS System 9 client is connecting to a session running a release of SAS prior to SAS System 9, you can use the `%LS( )` macro to set up the remote SAS environment for data transfer. As the Locale Setup Window did in previous releases, the `%LS( )` macro copies the host-to-host translation tables from the `LOCALE` catalog into SASUSER.PROFILE. The `%LS( )` macro does not set the encoding for the SAS session.

If you use SAS/CONNECT to connect to a remote SAS server, you will need to set up the server session for the locale that the SAS client is using. You must set up the server after signing on to the remote session from the client.

The following examples show how to set locale for remote connections:

**Connecting SAS System 9-to-SAS System 9:** Use the `LOCALE` option at startup. The `LOCALE` option value of the SAS client and server sessions should be the same. For example,

```
sas -locale Spanish_Spain
```

**Connecting SAS System 9 and a previous release of SAS:**

- SAS System 9 receives the data: Use the `LOCALE` option on the SAS System 9 side at start up.
  
  Example: `sas -locale Spanish_Mexico`

- Previous release receives the data: Start SAS System 9 with the `LOCALE` option at start up.
  
  Example: `sas -locale Spanish_Guatemala`

Then use the `%LS( )` macro in SAS System 9 to set up the host-to-host translation tables on the previous release after connection is established. For example, submit the following code from the Program Editor:

```
%ls(locale=Spanish_Guatemala, remote=on);
```

**Devmaps and Keymaps for SAS/GRAPH Software**

If you are running SAS/GRAPH software and you want to display non-ASCII characters, set the appropriate devmaps and keymaps to match your current encoding. The devmap and keymap entries are located in the `SASHELP.FONTS` catalog. To get the correct devmaps and keymaps for your encoding, you should use the `%LSGRAPH` macro.

There are two ways in which the `%LSGRAPH` macro automatically sets up an environment:

- copies the devmap and keymap entries that match your encoding to the `GFONT0.FONTS` catalog
- changes the name of the entry to the name `DEFAULT` so the devmaps and keymaps will be loaded for you.

The following example uses `%LSGRAPH` to set the correct devmap and keymap (WLT2) for a Polish user on the Windows for x64 platform:

```
libname gfont0 'your-font-library';
%lsgraph(wlt2);
```
Here is a list of the devmaps and keymaps that match the locales on your platform:

<table>
<thead>
<tr>
<th>Locale</th>
<th>Devmap and Keymap Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic_Algiria</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Bahrain</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Egypt</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Jordan</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Kuwait</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Lebanon</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Morocco</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Oman</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Qatar</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_SaudiArabia</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_UnitedArabEmirates</td>
<td>wara</td>
</tr>
<tr>
<td>Arabic_Tunisia</td>
<td>wara</td>
</tr>
<tr>
<td>Bulgarian_Bulgaria</td>
<td>wcyr</td>
</tr>
<tr>
<td>Byelorussian_Belarus</td>
<td>wcyr</td>
</tr>
<tr>
<td>Croatian_Croatia</td>
<td>wlt2</td>
</tr>
<tr>
<td>Czech_CzechRepublic</td>
<td>wlt2</td>
</tr>
<tr>
<td>Danish_Denmark</td>
<td>wlt1</td>
</tr>
<tr>
<td>Dutch_Belgium</td>
<td>wlt1</td>
</tr>
<tr>
<td>Dutch_Netherlands</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_Australia</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_Canada</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_HongKong</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_India</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_Ireland</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_Jamaica</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_NewZealand</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_Singapore</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_SouthAfrica</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_UnitedKingdom</td>
<td>wlt1</td>
</tr>
<tr>
<td>English_UnitedStates</td>
<td>wlt1</td>
</tr>
<tr>
<td>Estonian_Estonia</td>
<td>wbal</td>
</tr>
<tr>
<td>Finnish_Finland</td>
<td>wlt1</td>
</tr>
<tr>
<td>French_Belgium</td>
<td>wlt1</td>
</tr>
<tr>
<td>French_Canada</td>
<td>wlt1</td>
</tr>
<tr>
<td>French_France</td>
<td>wlt1</td>
</tr>
<tr>
<td>French_Luxembourg</td>
<td>wlt1</td>
</tr>
<tr>
<td>French_Switzerland</td>
<td>wlt1</td>
</tr>
<tr>
<td>German_Austria</td>
<td>wlt1</td>
</tr>
<tr>
<td>German_Germany</td>
<td>wlt1</td>
</tr>
<tr>
<td>German_Lichtenstein</td>
<td>wlt1</td>
</tr>
<tr>
<td>German_Luxembourg</td>
<td>wlt1</td>
</tr>
<tr>
<td>German_Switzerland</td>
<td>wlt1</td>
</tr>
<tr>
<td>Greek_Greece</td>
<td>wgrk</td>
</tr>
<tr>
<td>Hebrew_Israel</td>
<td>wheb</td>
</tr>
<tr>
<td>Hungarian_Hungary</td>
<td>wlt2</td>
</tr>
<tr>
<td>Icelandic_Iceland</td>
<td>wlt1</td>
</tr>
<tr>
<td>Italian_Italy</td>
<td>wlt1</td>
</tr>
<tr>
<td>Italian_Switzerland</td>
<td>wlt1</td>
</tr>
<tr>
<td>Latvian_Latvia</td>
<td>wbal</td>
</tr>
<tr>
<td>Lithuanian_Lithuania</td>
<td>wbal</td>
</tr>
<tr>
<td>Norwegian_Norway</td>
<td>wlt1</td>
</tr>
<tr>
<td>Polish_Poland</td>
<td>wlt2</td>
</tr>
<tr>
<td>Portuguese_Brazil</td>
<td>wlt1</td>
</tr>
<tr>
<td>Portuguese_Portugal</td>
<td>wlt1</td>
</tr>
<tr>
<td>Romanian_Romania</td>
<td>wlt2</td>
</tr>
<tr>
<td>Russian_Russia</td>
<td>cyr</td>
</tr>
<tr>
<td>Serbian_Yugoslavia</td>
<td>wcyr</td>
</tr>
<tr>
<td>Slovakian_Slovakia</td>
<td>wlt2</td>
</tr>
<tr>
<td>Slovenian_Slovenia</td>
<td>wlt2</td>
</tr>
<tr>
<td>Spanish_Argentina</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Bolivia</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Chile</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Colombia</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_CostaRica</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_DominicanRepublic</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Ecuador</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_ElSalvador</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Guatemala</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Honduras</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Mexico</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Nicaragua</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Panama</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Paraguay</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Peru</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_PuertoRico</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Spain</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_UnitedStates</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Uruguay</td>
<td>wlt1</td>
</tr>
<tr>
<td>Spanish_Venezuela</td>
<td>wlt1</td>
</tr>
<tr>
<td>Swedish_Sweden</td>
<td>wlt1</td>
</tr>
<tr>
<td>Turkish_Turkey</td>
<td>wtur</td>
</tr>
<tr>
<td>Ukrainian_Ukraine</td>
<td>wcyr</td>
</tr>
</tbody>
</table>
Chapter 3: SAS/ACCESS Interfaces

Configuring SAS/ACCESS Interface to MySQL Software

Before you can use SAS/ACCESS Interface to MySQL software, the following products are required:

- Base SAS software
- SAS/ACCESS Interface to MySQL software

Before you use SAS/ACCESS interface to MySQL software, verify that the MySQL client library has been appended to Path, a system variable. The MySQL client library is often located in C:\mysql\bin.

To locate the Path system variable, follow the instructions for your operating system.

- For Windows NT, right-click My Computer and choose Properties. Select the Environment tab and you will see in your list of system variables.
- For Windows 2000, right-click My Computer and choose Properties. Select the Advanced tab and select the Environment Variables button. You will see Path in your list of System Variables.
- For Windows XP, click Start then select Control Panel. Double-click System. Select the Advanced tab and select the Environment Variables button. You will see Path in your list of System Variables.

If you use MySQL Client version 4.1.0 or later, you will need to make a change because of client incompatibilities. The SASMYL SAS option must be updated so that the SAS/ACCESS Interface to MySQL can identify your version of the MySQL client. This can be done either in the beginning of your SAS program or in your SASV9.cfg file.

If you want to set the SASMYL option in your SAS Program, add the following line at the top of your SAS program:

```
options set=SASMYL MYWIN417
```

The SASV9.cfg file is located in your !SASROOT directory. To set the SASMYL SAS option in your config file, add the following line:

```
-set SASMYL MYWIN417
```

For more information about SAS/ACCESS Interface to MySQL, refer to the MySQL chapter in SAS/ACCESS 9.2 for Relational Databases: Reference.

Configuring SAS/ACCESS Interface to ODBC Software

Before you can use SAS/ACCESS Interface to ODBC software, the following products are required:

- Base SAS Software
- SAS/ACCESS Interface to ODBC Software
- A 32-bit ODBC driver for the source from which you want to access data

The ODBC solution allows different technologies to be used by defining a standard interface. SAS/ACCESS Interface to ODBC software with ODBC drivers provides you with access to different
databases. An ODBC driver processes ODBC function calls from—and returns results to—SAS/ACCESS software. You can get drivers from Microsoft, your database vendor, or other third party software vendors.

To run SAS/ACCESS software on 32-bit Windows, you need 32-bit drivers. The application calls the 32-bit Driver Manager (ODBC32.DLL), which in turn calls the 32-bit drivers. The following figure illustrates the architecture:

The ODBC Driver Manager and Administrator are Microsoft products that are included with all ODBC drivers. When you install an ODBC driver, the ODBC Driver Manager and Administrator are also installed. The ODBC Administrator should appear as an icon in the control panel. However, it can appear as an icon in the Start menu instead.

After you install the ODBC driver, you can use the ODBC Administrator to define and manage the data sources. A data source associates a particular ODBC driver with the data you want to access through that driver. It can consist of information about the data you want to access and its associated operating system, DBMS, and network platform (if any) used to access the DBMS. For information about how to configure your data sources, refer to the documentation provided with your ODBC drivers.

For more information about SAS/ACCESS to ODBC, refer to the ODBC chapter in SAS/ACCESS 9.2 for Relational Databases: Reference. For more information about ODBC, refer to Microsoft ODBC 3.0 Programmer’s Reference and SDK Guide.

**SAS/ACCESS ODBC Conversion Utilities**

The SAS/ACCESS ODBC Conversion Utilities are included in the SAS/ACCESS Interface to ODBC software. It helps users of Version 6 SAS/ACCESS Interface to AS/400 and SAS/ACCESS Interface to Microsoft SQL Server move from a native DBMS interface connection to an ODBC interface connection on SAS 9.2.

**AS/400 Users**

Before you can use the ODBC Conversion Utilities for AS/400 Interface, you need to install IBM’s Client Access ODBC Driver (32-bit) V3.00.0004 or above. If your AS/400 Client Access installation loaded a Client Access ODBC Driver prior to this release, you can download Program Temporary Fix
(PTF) SF59504 or later from ftp://ftp.software.ibm.com/ for an update. This service pack for the Client Access product can be found in the /as400/products/clientaccess/win32/v3r1m2/servicepack/ directory. When this update is applied, Version 3.00.004 or later of the ODBC driver should be installed.

You are also required to create a data source name. You can use the ODBC administrator to add it. The data source name AS400 is recommended. If you want to use another data source name, set the SAS environment variable AS400DSN, located in your sasv9.cfg, to the data source name you assigned. Quotes are required if blanks or special characters are included. You may want to create it as a system DSN instead of a user DSN if you have more than one user who might want to use the same workstation to access the AS/400 database.

Complete the following steps to create a data source for AS/400 database access:

1. Run ODBC Administrator from the Control Panel or Start menu: Start > Settings > Control Panel > (Admin Tools) on XP) Data Sources (ODBC).
2. Click the User DSN or System DSN tab, depending on the number of users.
3. Click the Add button and then choose Client Access ODBC driver (32-bit) from the pop-up windows.
4. Click Finish. This brings up the Setup dialog.
5. Click the General tab and enter AS400 (or another name) in the Data Source Name field. This name needs to match the value you set for the SAS environment variable AS400DSN.
6. From the pull-down menu, choose an AS/400 system that you want to connect to using this data source.
7. To change the method that this data source will use to connect, click Connection Options. Select the appropriate option and click OK.
8. Click the Server tab. The default library is QGPL. You can change this designation by deleting its name from under the Default Libraries filed and either entering a new library to use or leaving it blank.
9. Click the Format tab. Using the Naming Convention pull-down list, select System naming convention (*SYS).
10. Click the Package(s) tab. Uncheck the box for Enable Extended Dynamic Support.
11. Click OK to close the Setup window.

**Microsoft SQL Server Users**

An ODBC Conversion Utility is provided that will allow you to read SAS System Version 6 views to access data in Microsoft SQL Server which were created with SAS/ACCESS Interface to Sybase and SQL Server software on Windows. The Conversion Utility helps users migrate to SAS/ACCESS Interface to ODBC software on Windows.

*Note: The Conversion Utility applies only to views that access data in Microsoft SQL Server. It does not apply to SYBASE SQL Server.*

The ODBC Conversion Utility requires the Microsoft SQL Server ODBC driver (32-bit) from Microsoft. This driver is installed as part of Microsoft Data Access Components (MDAC).
It is recommended (but not required) to create a data source name. You can use ODBC administrator to add it. You must set the SAS environment variable MSSQLDSN, located in the sasv9.cfg, as the data source name you assigned. Quotes are required if blanks or special characters are included. You can create it as a system DSN instead of a user DSN if you have more than one user who may use the same workstation to access the Microsoft SQL Server database.

Complete the following steps to create a data source for Microsoft SQL Server database access:

1. Run ODBC Administrator from the Control Panel or Start menu.
2. Click the User DSN or System DSN tab, depending on the number of users, as stated above.
3. Click the Add button and choose SQL Server from the pop-up window.
4. Enter any name in the Name field. This name needs to match the value you set for the SAS environment variable MSSQLDSN.
5. Choose or enter the Server field which you defined using SQL Client Configuration Utility.
6. Click Next. Select the radio button that describes your login method. If necessary, enter a login ID and password.
7. Click Next. A connection will be initiated. If the connection succeeds, please refer to Step 8 below. If the connection fails, an error message will provide a reason for the failure.
8. After a connection succeeds, your default databases may be changed. Click Next to leave this screen.
9. After changing your default databases, other options may be selected. Click Finish when this screen is correct.
10. Click Test Data Source. After a message appears that indicates that the test was successful, click Okay. Click Okay on the following message as well.

Note: SAS 9.2 will automatically install Microsoft Data Access Components (MDAC) when you install SAS/ACCESS Interface to ODBC software.

Configuring SAS/ACCESS Interface to Oracle Software

Before SAS/ACCESS Interface to Oracle software can be used, the following products are required:

- Base SAS software
- SAS/ACCESS Interface to Oracle software
- Oracle client/server, Release 9i or above

After the Oracle client/server installation process is complete, ensure that the path to the Oracle client libraries is appended to the PATH system variable. The Oracle libraries are usually located in the directory ORACLE_HOME/bin. If the PATH variable does not have ORACLE_HOME/bin, you will see the following error:

ERROR: The SAS/ACCESS Interface to ORACLE cannot be loaded.

ERROR: Image SASORA found but not loadable.

For more information about SAS/ACCESS Interface to Oracle, refer to the Oracle chapter in SAS/ACCESS 9.2 for Relational Databases: Reference.
Chapter 4: Post-Installation Setup for SAS/ASSIST Software

This chapter describes how to add an optional master profile to SAS/ASSIST software. You can use a master profile to override the default settings as sent by SAS. This allows you to provide a customized setup for SAS/ASSIST software. With the master profile, you can control the profile options of all SAS/ASSIST users from one central place. For information on the profile options, refer to SAS/ASSIST Administrator’s Guide.

Adding a Master Profile

Complete the following steps to add a master profile to SAS/ASSIST software:

1. Specify the location of the master profile by creating a new directory that all users of SAS/ASSIST software will have read access to.

   All users with write access to this directory will automatically also have write access to the master profile in SAS/ASSIST software. Select a name that conforms to the naming conventions at your installation. The name of this new directory must be stored in an entry in the SASHELP library. This requires that you have write access to the SASHELP library.

   On line 1 of the Editor window of the SAS Display Manager System, type the physical pathname of the master profile directory. Execute the Save command to store this in the SASHELP.QASSIST catalog. For example:

   ```
   SAVE SASHELP.QASSIST.PARMS.SOURCE
   00001 S:\SAS\ASSIST\PARMS
   00002
   00003
   ```

   The location of the master profile is now known by SAS/ASSIST software.

2. Create the master profile.

   The first time SAS/ASSIST software is started, a master profile is created if SASHELP.QASSIST.PARMS.SOURCE contains the name of an existing physical pathname, and the person who starts SAS/ASSIST software has write access to this physical pathname.

3. Customize the master profile by starting SAS/ASSIST software and selecting Setup > Profiles > Master/group ...

   If you have write access to the SAS library containing the master profile, you can specify default values for your installation. New users will use these values as they start SAS/ASSIST software.

   **Note:** If you restrict values by typing R in Status, users will not be allowed to change the values you define.

   You can run SAS/ASSIST software in two different styles - workplace or block menu. The block menu can be new style or old style. You can control this using the profile options below.

   ```
   Run workplace:
   SAS/Assist style: Workplace
   Run block menu new style:
   ```
SAS/Assist style: Block Menu
Save selections on end: Yes
Menu Style: New
Run old style:
SAS/Assist style: Block Menu
Save selections on end: Yes
Menu Style: Old

By setting the default values in the master profile, you can control if users should use the new or old style of SAS/ASSIST software. In addition, there are many other profile options. For more information on these options, refer to SAS/ASSIST Administrator’s Guide.

4. Create group profiles.

From the master profile, it is possible to create group profiles to allow groups of users to have different setups. The master profile controls group profiles and user profiles when a user is not a member of any group. All users are indirectly controlled by the master profile when option values are set to a restricted (R) status.

From Setup > Master/Group..., select Tools > Create Group Profile. To add users to a group profile, select Tools > Update User Group. By default, the userid is found in the macro variable &SYSJOBID. This value is set in the option Userid in the master profile (option type System Administration). Change the value if your site uses another variable to keep the userid. If the value name starts with & , it is a macro variable; otherwise, it is an environment variable, which is set before the start of SAS 9.2.
Chapter 5: Post-Installation Setup for SAS/CONNECT Software

TCP/IP is the access method supported for SAS 9.2 on Windows for x64. For information about the access methods supported by other systems, refer to Communications Access Methods for SAS/CONNECT 9.2 and SAS/SHARE 9.2. This document can be found at http://support.sas.com/documentation/onlinedoc/.

Note: The APPC access method is not supported for the Windows for x64 operating system.

Storing and Locating SAS/CONNECT Script Files

Several sample script files are shipped with SAS/CONNECT software. SAS/CONNECT software uses these script files to establish a connection to a remote SAS session.

The $SASSCRIPT configuration option points to the location of the SAS/CONNECT script files. The $SASSCRIPT option is used by SAS/ASSIST software and can be used by user-written SCL applications.

Under Windows for x64, the script files are installed into the $SASROOT\CONNECT\SASLINK directory by default. The following line is added to the $SASV9.CFG file when SAS/CONNECT software is installed:

- $SASSCRIPT $SASROOT\CONNECT\SASLINK

If you want to move the script files to another directory, you must edit the $SASV9.CFG file and update the $SASSCRIPT option with the new directory location. This option can also be specified from the Tools/Options/System/Communications/Networking and encryption selection in DMSEXП mode.

TCP/IP

TCP/IP is the access method supported for SAS 9.2 on Windows for x64. SAS/CONNECT software supports Microsoft’s TCP/IP System Driver, which is provided with Windows for x64.

Configuring the SAS Windows Spawner Program

The SAS Windows Spawner is stored in the $SASROOT directory and can be executed manually from the $SASROOT directory at any time. You can run the SAS Windows Spawner as a service by executing SPAWNER.EXE with the -install option. By default, the SAS Windows Spawner will be installed to run with security. For complete documentation on the Windows Spawner and the supported options, see Communications Access Methods for SAS/CONNECT 9.2 and SAS/SHARE 9.2.

Note: If you are upgrading to SAS 9.2 and you run a spawner from a previous release as a service, you should stop and delete the existing spawner service. The SAS 9.2 CONNECT spawner can then be installed as a Windows service.

By default, when the SAS Windows Spawner is installed as a Windows service, it runs under the LocalSystem userid that has all required User Rights for running the SAS Windows Spawner. If you do not install the SAS Windows Spawner as a Windows service (run it from your system prompt), the Windows userid used to start the SAS Windows Spawner must be the local Administrator of the machine and must have the following User Rights:

- act as part of the operating system
• bypass traverse checking (the default is everyone)
• increase quotas
• replace a process level token
• log on locally (the default is everyone)

The Windows userid specified at signon needs only the User Right “log on as a batch job.”
Chapter 6: Post-Installation Configuration for SAS/IntrNet Software

This chapter has information for your SAS/IntrNet installation. It will help you install, configure, and test your SAS/IntrNet components.

The procedures for installing SAS software using the SAS Deployment Wizard are described in other documentation and are not available in this chapter. In addition, the installation of a Web server it is not described in SAS documentation because it is the administrator’s responsibility.

When SAS/IntrNet software has been installed, configured and tested using the procedures described in this chapter, review the latest version of the SAS/IntrNet product documentation online at http://support.sas.com/documentation/onlinedoc/IntrNet/index.html. The “What’s New” page at this Web site lists any recent changes to the product or documentation.

Overview

All SAS/IntrNet installations are made up of two components:

1. The SAS/IntrNet server (also referred to as the Application Server). This is where SAS Foundation is installed.

2. CGI Tools (also referred to as the Broker). This is where the broker.cfg file and its supporting files are installed.

When you install SAS/IntrNet, choose between these two installation configurations:

- Type A - The SAS/IntrNet server and CGI Tools components are both installed on the same system machine. The Web server must be installed before starting the SAS installation.

- Type B - The SAS/IntrNet server component is installed on one system machine and the CGI Tools component is installed on a different system machine. The Web server must be installed on the CGI Tools system prior to installing CGI Tools.

Type A and Type B require different installation steps:

<table>
<thead>
<tr>
<th>Type A Installation Steps</th>
<th>Type B Installation Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm that the Web server software (IIS, Apache etc.) is on the same server as your SAS/IntrNet system.</td>
<td>Confirm that the Web server software (IIS, Apache, etc.) is on the machine where you will install the CGI Tools.</td>
</tr>
<tr>
<td>Install your SAS products. Check “CGI Tools for the Web Server” and “SAS/GRAPH Java Applets” in the “Select Products to Install” menu.</td>
<td>On your application server system, start your SAS installation. Uncheck “CGI Tools for the Web Server” in the “Select Products to Install” menu.</td>
</tr>
<tr>
<td></td>
<td>On your Web server system machine, start your SAS installation. Uncheck all products except “CGI Tools for the Web Server” and “SAS/GRAPH Java Applets” in the “Select Products to Install” menu.</td>
</tr>
</tbody>
</table>
### Install Your Web Server Software

Refer to your *QuickStart Guide* for a description of how to start your SAS software installation.

### Install Your SAS Software

If you are performing a Type A installation (as described in the “Overview” above), confirm that your Web server software is installed before starting your SAS software installation. Check “CGI Tools for the Web Server” and “SAS/GRAPH Java Applets” in the *Select Products to Install* dialog.

If you are performing a Type B installation, do both of the following:

- Install the SAS software on the SAS System side, unchecking “CGI Tools for the Web Server” and “SAS/GRAPH Java Applets” in the *Select Products to Install* dialog.

- Start the SAS software install on the Web server and check “CGI Tools for the Web Server” and “SAS/GRAPH Java Applets” in the *Select Products to Install* dialog. SAS/IntrNet Monitor and SAS/CONNECT Driver for Java are optional selections. Uncheck everything else.

### CGI Tools Installation Dialogs

The following windows appear for CGI Tools for the Web Server and SAS/GRAPH Java Applets for all installations. For information about the fields, click *Help* on any dialog.

Customary entries are documented following each screen shown below. Customize the entries according to your environment.
Deployment Directory for SAS/GRAPH Java Applets:

This is part of the SAS/GRAPH Java applets installation. The applets can be installed in any valid folder location.

This location will be available to the CGI Tools installation, which will copy the graph applets to the /sasweb/graph directory on the Web server.
The following are examples of common entries for popular Web servers. Customize your entries according to your own Web server environment. These fields will tell SAS where your Web server software is located.

**Physical path corresponding to http://<your_server>/sasweb:**

- **IIS:** C:\Inetpub\wwwroot\sasweb
- **Apache (Windows):** C:\program files\Apache Software Foundation\Apache2.2\htdocs\sasweb
- **Apache (UNIX):** /usr/local/apache2/htdocs/sasweb

**Physical path for SAS/IntrNet CGI Executables:**

- **IIS:** C:\Inetpub\scripts
- **Apache (Windows):** C:\program files\Apache Software Foundation\Apache2.2\cgi-bin
- **Apache (UNIX):** /usr/local/apache2/cgi-bin

**URL for CGI Executables:**

- **IIS:** http://<web_servername>/scripts
  
  Example: http://abcservers.comp.com/scripts
- **Apache (Windows):** http://<web_servername>/cgi-bin
  
  Example: http://abcservers.comp.com/cgi-bin
- **Apache (UNIX):** http://<web_servername>/cgi-bin
  
  Example: http://abcservers.comp.com/cgi-bin
Note that your entries for this dialog are added to the `broker.cfg` file. The `broker.cfg` file is a text file that can be edited after the installation is complete.

**Name of the Service Administrator:**

(optional) Enter the name of the administrator (for example, John Doe).

**Email Address of the Service Administrator:**

(optional) Enter the e-mail address of the administrator (for example, NetAdmin@comp.com).

**DNS Name or IP Address of Application Server Host:**

Enter the DNS name or IP address of the application server host where SAS Foundation is located.

**TCP Port Number for Application Server:**

The customary default port number is 5001, but you can use any valid available port on your system between 256 – 65535.

Click **Next** at this dialog unless you are using JConnect. If you are using JConnect, enter values that are valid for your site.

**Installing CGI Tools and SAS Foundation on Machines with Different Operating Systems**

Your SAS Foundation system’s operating system might be different than your CGI Tools system’s operating system. For example, your SAS Foundation might be installed on a Windows system and your CGI Tools might be installed on a UNIX system. The CGI Tools installation from the SAS Deployment Wizard will detect the destination operating system and install the appropriate operating system-specific software.
There are two methods to make the SAS Software Depot available to the installer on the destination CGI Tools system. Choose the method that is appropriate for your site’s available facilities:

- Launch the set-up from a SAS Software Depot that resides on a remote system. You might need to use a cross-platform file access method such as NFS or SAMBA to connect the two systems.
- Create media from an existing depot using the SAS Deployment Wizard and use that media on the host machine. This process is described more thoroughly in the SAS Deployment Wizard Users Guide, available from Install Center (http://support.sas.com/documentation/installcenter/92/documents/index.html).

Note: SAS/IntrNet operation requires TCP/IP connectivity between the SAS Foundation system and the CGI Tools system, regardless of the operating systems on which these components are installed.

Test the Web Server
To determine if the Web server is running, launch the Web server’s browser and enter http://localhost. This will return a Web page if the Web server is running.
If you do not receive a Web page, you must debug or reinstall your Web server before continuing.

Test the Application Broker
To verify that CGI Tools was installed correctly and can access the broker.cfg file, point your Web browser to the following URL:

Windows:
- IIS: http://<web_servername>/scripts/broker.exe
- Apache: http://<web_servername>/cgi-bin/broker.exe

Other hosts:
http://your_webserver/cgi-bin/broker
Replace your_webserver with the name of the Web server. The URL path might also need to be changed if you installed CGI Tools to a different directory. You should see a Web page similar to the following:

SAS/IntrNet Application Dispatcher
Application Broker Version 9.2 (Build 1494)
Application Dispatcher Administration
SAS/IntrNet Samples
SAS/IntrNet Documentation — requires Internet access

If you do not receive this page, you must debug your Web server installation before continuing.
Verify that your Web server is enabled for CGI execution in the directory where you installed the Application Broker (broker.exe and broker.cfg files). This directory was determined by what was entered for Physical path for SAS/IntrNet CGI Executables during the CGI Tools installation above.
Configure a Default Application Dispatcher Service

You must create a default Application Dispatcher service to run any of the sample programs supplied with SAS/IntrNet. You should create the default service with the SAS/IntrNet Configuration Utility inetcfg. Services can be created on Windows platforms with a configuration utility that is accessible from the Start menu.

Perform the following steps to create and start the default service:

1. From the Start menu, select Programs ➤ SAS (or other program group where SAS is installed) ➤ IntrNet ➤ Create a New IntrNet Service.
2. The IntrNet Config Utility Welcome window appears. Read the information in the Welcome window, and then select Next to continue.
3. Select Create a Socket Service, then select Next to continue.
4. Type default as the name of the new service. Select Next to continue.
5. Specify the directory where you want the configuration utility to place your service directory and control files. The default location (under your SASROOT directory) is recommended. Select Next to continue.
6. Type the TCP/IP port number that you reserved for the default Application Dispatcher service. Select Next to continue.
7. A password is not necessary for the default service. You can add an administrator password later if you use this service for production applications. Select Next to continue.
8. The Create Service window displays all of the information that you specified for this service. Verify that the information is correct and then select Next to create the service.
9. Select Next and then Finish to complete the setup of the default service.
10. From the Start menu, select Programs ➤ SAS (or other program group where SAS is installed) ➤ IntrNet ➤ default Service ➤ Start Interactively. Your default Application Server should now be running.

Starting and Stopping the Default Service

As stated above, from the Start menu, select Programs ➤ SAS (or other program group where SAS is installed) ➤ IntrNet ➤ default Service ➤ Start Interactively. Your default Application Server should now be running.

Testing the Socket Service

1. To make sure that the service was installed and started correctly, point your Web browser to this URL:

   Windows:
   - IIS: http://<web_servername>/scripts/broker.exe
   - Apache: http://<web_servername>/cgi-bin/broker.exe

   Other hosts:
   - http://your_webserver/cgi-bin/broker
Replace `your_webserver` with the name of the Web server. The URL path might also need to be changed if you installed the Application Broker to a different directory. You should see the following Web page:

**SAS/IntrNet Application Dispatcher**

Application Broker Version 9.2 (Build 1494)

Application Dispatcher Administration

SAS/IntrNet Samples

SAS/IntrNet Documentation - requires Internet access

2. Click on the **Application Dispatcher Administration** link to see if the Application Broker can read the `broker.cfg` file. The Application Dispatcher Services Web page should open.

3. Verify connectivity between the Application Server and the Web server. Click on the **Application Dispatcher Administration** link and then click on the **ping** link under **SocketService default** heading. If the ping is successful, you should see:

   Ping. The Application Server <hostname>:<port_number> is functioning properly.

4. To complete installation testing, type this URL in your browser address line:

**Windows:**

IIS:

http://your_webserver/scripts/broker.exe?_service=default&_program=sample.webhello.sas

Apache:

http://your_webserver/cgi-bin/broker.exe?_service=default&_program=sample.webhello.sas

**Other hosts:**

http://your_webserver/cgi-bin/broker?_service=default&_program=sample.webhello.sas

You should see the string “Hello World!” in large bold type in your browser. If you do not, add the debug option to create a log:

**Windows:**

IIS:

http://your_webserver/scripts/broker.exe?_service=default&_program=sample.webhello.sas&_debug=131

Apache:

http://your_webserver/cgi-bin/broker.exe?_service=default&_program=sample.webhello.sas&_debug=131

**Other hosts:**

http://yourWebserver/cgi-bin/broker?_service=default&_program=sample.webhello.sas&_debug=131

Save the log screen on the browser for SAS Technical Support.
Configure Additional Services

This chapter describes how to configure only a simple default Application Dispatcher service. There are many reasons you may want to configure additional services, including segregating applications by security or performance requirements and implementing more scalable servers. See the “Using Services” section of the SAS/IntrNet Application Dispatcher documentation at http://support.sas.com/documentation/onlinedoc/intrnet/index.html information on configuring additional services, using the Load Manager, and adding pool services.
Chapter 7: Installing SAS/SECURE Software Client Components

SAS/SECURE software includes client components that non-SAS System client applications can use to communicate with a SAS server in a secure environment. To use encryption between a non-SAS System client and a SAS server with SAS/SECURE software licensed, you must install the SAS/SECURE client components on the client machine. The SAS/SECURE client components are available in the SAS/SECURE folder accessible through the SAS Software Navigator.

Note: This installation is not necessary if the SAS System is your client. The SAS System installs the components that it needs as part of the SAS System install process.

SAS/SECURE for Windows Clients

The SAS/SECURE components needed by Windows clients can be installed by running the SAS Software Navigator to access the SAS/SECURE Windows Client Components. The secwin.exe executable available in this folder installs the files necessary for the IOM Bridge for COM to use the CryptoAPI algorithms.

SAS/SECURE for Java Clients

The SAS/SECURE components for Java clients provide encryption support for Java applications. You can incorporate this support into applications that are written using the following components:

- SAS/SHARE driver for JDBC
- SAS/CONNECT driver for Java
- IOM Bridge for Java

The SAS/SECURE components needed by Java clients can be installed by running the SAS Software Navigator to access the SAS/SECURE Java Component. This folder contains two JAR files that enable Java clients to use the CryptoAPI algorithms:

- sas.rutil.jar - should be copied to the location where the client you are running gets started
- sas.core.jar - included in case you do not already have one however, this will probably not be needed

The sas.rutil.jar file should be copied to the location(s) where you installed each of the following products. They are listed below with their respective default installation locations.

- for SAS MC, <SAS_HOME>\SASManagementConsole\9.2
- for OLAP Cube Studio, <SAS_HOME>\SASOLapCubeStudio\9.2
- for SAS Data Integration Studio, <SAS_HOME>\SASETLStudio\9.2
- for SAS Information Map Studio, <SAS_HOME>\SASInformationMapStudio\1.0

In these examples, <SAS_HOME> is specified through the SAS Software Navigator, with C: \ Program Files\SAS as the default.

After the file is copied where you need it, you can use algorithms other than sasproprietary.
Chapter 8: Post-Installation Setup for SAS/SHARE Software

This chapter discusses the use of the TCP/IP access methods with SAS/SHARE software. TCP/IP is the access method supported for SAS 9.2 on Windows for x64. For information about the access methods supported by other systems, please visit http://support.sas.com/documentation/onlinedoc/ and refer to Communications Access Methods for SAS/CONNECT 9.2 and SAS/SHARE 9.2.

Using the TCP/IP Communications Access Method

Communication between a SAS/SHARE server and user is handled by the TCP/IP communications access method, which is a part of SAS 9.2 that uses underlying communications software to exchange messages and data. The TCP/IP access method requires Microsoft’s TCP/IP Network Protocol communications software.

Note: The APPC access method is not supported for the Windows for x64 operating system.

To use the TCP/IP access method, you must have the supporting software on each workstation on which a SAS/SHARE server or user will execute.

System Configuration for the TCP/IP Access Method

SAS/SHARE software supports Microsoft’s TCP/IP Network Protocol, which is provided with Windows for x64.

To define server names in the TCP/IP SERVICES file, complete the following steps:

1. Locate the SERVICES file.

   This file is located under the \windows or \winnt directory paths depending on the specific Windows operating system and upgrade method. For example, under a machine configured with a Windows 2000 operating system, the directory path is named

   <drive letter>:\winnt\system32\drivers\etc

2. Specify the server names and port assignments.

   Each SAS/SHARE server that runs on a network must be defined as a service in the SERVICES file. Each entry in this file associates a service name with the port number and protocol used by that service. An entry for a SAS/SHARE server has the form:

   <server name>   <port number>/<protocol>   # <comments>

   The server name must be 1-8 characters in length. The first character must be a letter or underscore. The remaining seven characters can include letters, digits, underscores, the dollar ($) sign, or the at (@) sign. The port number must be above 1024, as any port number equal to or less than 1024 is reserved. The protocol must always be TCP.

   An entry for a server with the name MKTSERV might look like this:

   mktserv   5000/tcp   # SAS server for Marketing and Sales

   The server name is specified with the SERVER= option in the PROC SERVER statement in the server’s SAS session and in the PROC OPERATE and LIBNAME statements in user and server
administrator programs. If the server name is not defined, you must use __port#, for example, server= __5012.

For more information about the options used with PROC SERVER and PROC OPERATE procedures, please refer to the SAS/SHARE 9.2 User’s Guide.

**Client-Side Components**

SAS/SHARE software includes client components that are used outside of your SAS installation. These components are available from the SAS 9.2 Software Download site and are described below:

**SAS/SHARE Data Provider**

The SAS/SHARE data provider enables you to access, update, and manipulate SAS data using OLE DB- and ADO-compliant applications on Windows platforms.

**SAS ODBC Driver**

The SAS ODBC driver enables you to access, update, and manipulate SAS data from ODBC-compliant applications on Windows platforms.

**SAS/SHARE Driver for JDBC**

The SAS/SHARE driver for JDBC enables you to write applets, applications, and servlets that access and update SAS data. The Java Tools package that includes the SAS/SHARE driver for JDBC also includes the SAS/CONNECT driver for Java. If you are writing Java programs using these interfaces, you may also want to use the tunnel feature. This optional feature can be used with the Java applets you write to solve some common configuration problems.

**SAS/SHARE SQL Library for C**

The SAS SQL Library for C provides an application programming interface (API) that enables your applications to send SQL queries and statements through a SAS/SHARE server to data on remote hosts.

**NLS Information**

Sites that develop or support international applications that use SAS/SHARE software should refer to the chapter Post-Installation Instructions for National Language Support (NLS) on page 3.
Chapter 9: Post-Installation Setup for SAS/STAT Software

The Web application SAS/STAT Power and Sample Size is provided with SAS/STAT software, but it is installed separately. The application is available on the SAS Mid-tier Components CD. Detailed installation instructions and a list of required SAS products can also be found there.

Overview

SAS/STAT Power and Sample Size is a user interface that provides power and sample size computations. The application includes tasks for determining sample size and power for a variety of statistical analyses, including the following:

- t tests
- confidence intervals of means
- proportions
- equivalence testing
- ANOVA
- linear models
- survival analysis

The application provides multiple input parameter options, stores results in a project format, displays power curves, and produces appropriate narratives for the results.

Because SAS/STAT Power and Sample Size is a Web application, it requires Web server software. To run a Java virtual machine, the Web server must contain a servlet container. Specifications for the servlet container are in the SAS/STAT Power and Sample Size Installation Instructions.

Configuration

SAS/STAT Power and Sample Size can be installed in either of two configurations: local or remote. The configurations differ in terms of where the necessary components are expected to run. The application requires these three components: the Web server, the SAS software, and the Microsoft Internet Explorer Web browser.

Local (Standalone) Configuration

In the local configuration, SAS/STAT Power and Sample Size can run in a standalone manner, that is, without access to the Internet. The Web server, the SAS software, and Microsoft Internet Explorer must all be installed on the same machine. Because Internet Explorer is required, this configuration is only available on PCs running Windows operating systems.

The Apache Tomcat servlet container is available as an optional part of the SAS/STAT Power and Sample Size installation. It can be used as a Web server in this standalone environment. You may also choose to install the Web server and servlet container from a third-party source.

Remote Configuration

In a remote configuration, the application, Web server, and Web browser are not on the same machine. The Web server and servlet container must be installed from a third-party source.
Additional SAS software products are required—specifically, SAS/CONNECT and a license for either SAS Integration Technologies or SAS/IntrNet. The SAS server administrator installs and runs the SAS/CONNECT spawner program. The administrator also provides information to the person installing SAS/STAT Power and Sample Size, who needs to know the machine name of the SAS server, the port for which the spawner is configured, and whether a user name and password are required by the SAS server. If the SAS server is running on a UNIX system, the person who installs SAS/STAT Power and Sample Size will also need the SAS command that the spawner uses to submit the job to SAS.

**Installation**

SAS Foundation software should be installed before the SAS/STAT Power and Sample Size application is installed. Full installation instructions are provided on the Mid-tier Components CD. The installation process copies the application WAR (Web archive) file to a directory on the Web server. It does not deploy the application to the Web server itself. The person who installs the application must do that as a separate step.

**Deployment in the Web Server**

After installation, the application’s WAR file must be deployed to the Web server. The deployment procedure varies depending on the Web server. For more information, please see the documentation for your specific Web server. If you are using an Apache Tomcat server that was installed as part of the application, please see your SAS/STAT Power and Sample Size Installation Instructions for more details.

**Making the Application Available to Users**

When installation and deployment of the application is completed, the Web address (URL) of the SAS/STAT Power and Sample Size application must be provided to users. The syntax of the URL varies among Web servers. The URL for the local (standalone) configuration is described in the SAS/STAT Power and Sample Size Installation Instructions.
Chapter 10: Windows Performance Monitor and Event Log Support

Support for Windows Performance Monitor allows advanced users and administrators to observe some internal characteristics of SAS 9.2 Foundation. This facilitates performance analysis and tuning of SAS 9.2.

Also, support for the Event Log allows the tracking of critical errors in SAS 9.2 Foundation and SAS Setup.

The user account installing SAS 9.2 Foundation must have administrator privileges to install these features, so non-administrators will not get these features by default. They can be added later by invoking setup.exe (found under the sas folder on the Setup Disk) with the following command lines:

To install the Windows Performance Monitor and Event Log:

```
setup perfmon
```

To uninstall the Windows Performance Monitor and Event Log:

```
setup uperfmon
```
SAS is the world leader in providing software and services that enable customers to transform data from all areas of their business into intelligence. SAS solutions help organizations make better, more informed decisions and maximize customer, supplier, and organizational relationships. For more than 30 years, SAS has been giving customers around the world the Power to Know®. Visit us at www.sas.com.

support.sas.com